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ALPHA OMEGA PRODUCTS 

LIMITED WARRANTY  

Alpha Omega LTD., warrants that their Products will be in good working order for a period 
of one year* from the date of shipment from Alpha Omega.  If the Product is not in good 
working order, the Purchaser shall notify Alpha Omega or its authorized representative 
promptly. 
If the Product fails within the warranty period, Alpha Omega will provide parts and labor at 
no additional cost, to repair or to replace, at its sole option, the necessary components of the 
Product.  The repair or replacement parts will be furnished on an exchange basis, and will be 
either reconditioned or new.  If the Product is not in good working order, the Purchaser s 
sole remedy shall be repair or replacement as set forth above. 
This limited warranty does not include service to repair damage resulting from accident, disaster, 
misuse, or modifications by parties other than Alpha Omega or its authorized representatives unless 
granted by Alpha Omega.  The postage, insurance, and shipping costs incurred in presenting or 
shipping the Product or components for service are the responsibility of the Purchaser. 

THE PURCHASER IS RESPONSIBLE FOR DETERMINING WHETHER THE 
PRODUCT PURCHASED MEETS THE PURCHASER S NEEDS.  THE PURCHASER IS 
RESPONSIBLE FOR THE USE OF THE PRODUCT AND FOR THE RESULTS OF ITS 
USE.  ALPHA OMEGA SELLS THEIR PRODUCTS AS IS WITHOUT WARRANTY 
OF ANY KIND, INCLUDING ANY EXPRESS OR IMPLIED WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE WITH THE 
EXCEPTION OF THE EXPRESS TWO YEAR LIMITED WARRANTY MENTIONED 
ABOVE.  IN NO EVENT SHALL ALPHA OMEGA LTD., BE LIABLE FOR ANY LOSS, 
INCONVENIENCE, OR DAMAGES, WHETHER DIRECT, INCIDENTAL OR 
CONSEQUENTIAL, ARISING OUT OF THE USE OF, OR INABILITY OF USE, THE 
PRODUCT. 
THE PURCHASER ASSUMES THE RISK AS TO THE QUALITY AND 
PERFORMANCE OF THE PRODUCT.  SHOULD THE PRODUCT PURCHASED 
PROVE TO BE DEFECTIVE, THE PURCHASER, AND NOT ALPHA OMEGA, SHALL 
ASSUME THE ENTIRE COST OF ALL-NECESSARY REPAIRS, SERVICING, OR 
CORRECTIONS, EXCEPT AS STATED ABOVE.  ALPHA OMEGA DOES NOT 
WARRANT THAT THE PRODUCTS WILL OPERATE WITHOUT DEFECTS. 
SOFTWARE LICENSE 
ALPHA OMEGA LICENSES THE SOFTWARE PROVIDED WITH THE PRODUCT 
(EXCLUDING THE WINDOWS SOFTWARE) THAT IS CONTAINED IN READ ONLY 
MEMORY (ROM) AND ON DISK, TO THE PURCHASER.  THE PURCHASE MAY 
NOT COPY THE SOFTWARE THAT IS IN ROM.  THE PURCHASER MAY COPY THE 
SOFTWARE THAT IS ON DISK FOR BACKUP PURPOSES ONLY. 
*Note:  For those who purchased a computer from Alpha Omega: The computer and its software 

have their own warranty which is not included in the two year warranty stated above.    
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Preface
The MCP-Plus User's Manual provides all the information needed to install and 
operate the MCP-Plus effectively.  We recommend that the first-time user read 
through the entire manual before operating the MCP-Plus.  

The MCP-Plus User's Manual is divided into the following sections:  

1. Introduction: This section provides an overview of MCP-Plus highlights and it s 
operating environment, including diagrams of the MCP-Plus signal conditioning 
system. 

2. Installation:  This section describes the installation procedure for the system s 
various modules. 

3. Operation: This section provides detailed instructions on operating the MCP-
Plus. 

4. Troubleshooting: This section presents solutions to possible problems that may 
arise while operating the MCP- Plus.  
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1 Introduction 
1.1 General Description 

The MCP- Plus is a modular amplification and filtering system designed to amplify 
and filter almost any physiological analog input.   

The MCP-Plus is available in two models: 

1. MCP-Plus 8 - a non-modular 8 channel Multi Channel Processor.  

2. MCP-Plus - a modular Multi-Channel Processor, up to 256 channels, with a 
minimum of 16 channels, channels can be added in multiples of 4. 

Both models offer the same functions are offered for both systems, these include: 

Gain amplification 

AC and DC coupling 

Low pass filtering 

DC level shifting 

Sine Generator for Impedance Measure of input electrode 

The MCP- Plus is a rack-mountable system that is controlled by a computer. Since 
the signal conditioning and data acquisition software control all parameters there are 
no manual controls on the front panel, eliminating the need to record or remember the 
parameters setting. Parameters and setting are saved and set by the software 
providing increased user convenience, especially when using a large number of 
channels.  

The MCP-Plus consists of the following components: 

A chassis that holds the different modules 

A linear power supply 

Control module 

Analog Input/Output modules  

8 - 256 outputs (both modular and non-modular) 

The MCP- Plus has up to 256 differential, low noise, inputs. Inputs can be sent 
directly to the MCP, or they can be received from a Pre-amplifier or a Head Stage. 

Each MCP channel has 2 outputs: a filtered output, and an "unfiltered" output that 
can be used for further conditioning or for archiving. 

The gain, filters and DC level shifting are controlled by the software and can be 
easily adjusted on the PC screen and saved to disk. 

A 2-pole Butterworth High-pass filter and a 4-pole Low-pass filter are provided and 
can be controlled by the software. 

The status of the MCP-Plus can always be read on the PC screen. 

The MCP-Plus also provides special functions that are useful for measuring 
activities from the nervous system using extra cellular microelectrodes.   
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The electrode s impedance can be measured easily using the mouse, by clicking the 
on/off impedance circle on the PC screen. 

A stimulus option can be switched On/Off by using the mouse to click the on/off 
stimulus control on the PC screen. 

The MCP allows the user to control the electrode selection for current injection and 
stimulus. 

The MCP is equipped with DC floating power supplies that supply the DC voltages 
to the MCP, and for Pre-amplifiers or for Head Stage units. 

An RS232 link to the PC is provided to control the MCP via the PC. 

The MCP-Plus is designed for specific user defined configurations. 

An external shut-off connector on the rear panel enables the user to shut off all 
channels simultaneously. 

The head stage control connector on the rear panel of each module may be used to 
shut off each channel individually.  
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1.2 Features and Benefits 

Up to 256 Modular Channels (electrodes)  
High Impedance Differential Inputs 
Filtered Outputs 
Notch Filter (50-60Hz) 
Unfiltered Outputs 
Flexible Gain Selection  
Flexible Filter Selection (2 and 4 pole Butterworth) 
DC Level Shifting 
Electrode Impedance Measure per Module 
External Stimulation On/Off switch 
Head Stage Control per Module 
Stimulus Control  
Audio Mixer 
Serial Communication (RS232) to PC 
User-Friendly Software Package 
Compatible with the MSD - Multi-Spike Detector and other standard data acquisition 
systems.  

Figure1: MCP-Plus Modular system Front Panel      
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Figure 2: MCP-Plus Modular system Rear Panel    

   

MCP-Plus Modular system - Identification of Parts 

1 Hole for mounting the MCP-Plus on Rack 
2 Fastening screw  
3 BNC Output 
4 Channel On/Off LED Indicator 
5 Communication error LED Indicator 
6. Power On/Off Switch 
7. Control Lines Connector for cascading 
8. Mains power receptacle, Line Filter, 110/220 Voltage control and fuses 
9. Digital I/O (stimulator control) 
10. Digital I/O (Mixer control) 
11. Serial RS232 connector for communication with PC 
12. Control and DC power supply for Pre-Amp 
13. Input Connector 
14. Output Connector 
15. Ground Connectors                   
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                                                                                                Figure 3: MCP-Plus 8 system Front Panel    

    

MCP-Plus 8 - List of Parts  

1. Hole for mounting the MCP-Plus on Rack 
2. Power On/Off Switch  
3. Power On Indicator 
4. Channel On/Off LED Indicator 
5. BNC Output 
6. Output Connector 
7. Input Connector 
8. Control and DC power supply for Pre-Amp. 
9. Audio Mixer input. 
10. Audio Mixer output. 
11. Digital Control I/O connector 1 (Audio Mix Control, External Stimulation On/Off switch)  
12. Digital Control I/O connector 2 (Stimulator control) 
13. Serial RS232 connector for communication with PC 
14.   MCP+ Ground 
15.   Line Ground  
16. Mains power receptacle, Line Filter, 110/220 Voltage control and fuses 
17. & 18.  Bus connectors, these connectors are for future use.   
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1.3 MCP-Plus Technical Specifications 
MCP-Plus modules and components: 

- Analog I/O modules 

- Notch filter 

- Control Module 

- Linear power supply / Isolation transformer 

- Linear power supply for Pre-amplifier or Head Stage 

- Casing 

- Power cord  

- Communication software package 

- Communication cable 

Technical Specifications 

Dynamic range     10V 
Input impedance    1M  || 2PF 
Frequency response    DC- 10KHz 
Noise (1 Hz- 10KHz BW)   <10 V RMS 
Differential Inputs CMRR   110 dB 

DC level shifting (R.T.I)   50 V to 3V 
Gain selection (including HS gain, X 25 )  Up to 63,750 
High pass (2 pole Butterworth)   DC -1KHz 
Low pass (4 pole Butterworth)   100Hz-10KHz  

Sine wave generator (for imp. measure) 100mV, 1KHz 

RS232 (Serial Communication to PC) 
Baud rate     9600 

Linear Power Supply   

Line voltage     100VAC, 60Hz 50Hz        
110VAC, 60Hz or        
220VAC, 50Hz  

DC outputs     +12V, -12V, +5V 

Housing  

Rack mountable      19" 
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1.4 Differential input Head Stage -Technical Specifications   

Dynamic Input range 1V 

Dynamic Output range 10V 

Input impedance 100M

 

CMRR ~110 dB 

Frequency response DC - 10KHz  

Noise (1 Hz- 10KHz BW) <10 V RMS 

Gain 10 

Supply 12V, 5V - Supplied from the MCP 

Case dimensions 3" X 1" X 0.5" (75 X 26 X 13 mm) 

Weight 55 Grams  
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2 Installation 
2.1 General 

The MCP-Plus is a signal-conditioning system that can receive 8 to256 channels 
from the input signal or from Pre-amplifiers or Head Stages via a cable, outputting 
the processed signals to a system like the MSD or any other data acquisition system. 

2.2 Installing the MCP-Plus in Rack 
Mount the MCP-Plus on the rack by inserting screws into the holes on the sides of 
the MCP-Plus. 

2.3 The Pre-Amplifier Head Stage 
The Pre-Amplifier Head Stage, along with the MCP-Plus, makes a very low noise 
and easy to install system that can accommodate all kinds of electrophysiological 
labs.  They are designed in a way that they can be suited to the ground setup of the 
lab. Installing the head stage Pre-Amplifier and connecting it to the subject animal 
and to the MCP-Plus and to the ground is the most delicate part and should be done 
by an expert who is familiar with handling low noise systems for measuring small 
signals.  If the input source comes from a high impedance source, such as a 
microelectrode that has a high impedance of several Mega Ohms, it makes it more 
difficult to eliminate the noise, as the high impedance source works like an antenna 
that might collect all kinds of surrounding noises. In addition to all the functions and 
options supplied by the Head Stage Pre-Amplifier, it is recommended to shield the 
area surrounding the place of recording with a good shielding to help eliminate 
surrounding noises collected by the high impedance microelectrode.         

      

Head stage pre-amps     

Stimulation 
connector 

Output connector  
(to interface box)

 

4 channels inputs 
connectors          
(to microelectrode)
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2.4 MCP-Plus and Pre-Amplifier Head Stage Connections 
If the Head Stage Preamplifiers are purchased along with the MCP-Plus, an interface box & 
two cables are supplied together with the pre-Amps. The pre-amps can be       1 OR 2 OR 3 
OR 4 channels, and connected to the interface box, with the short cable, then the interface 
box is connected to the MCP with the long cable. The long cable connects between the MCP-
Plus and the interface box outputs. D-type 15 pin connectors terminate the cable. Plug the 
designated MCP connector into the corresponding input located on the rear panel of the 
MCP-Plus. Plug the designated HS connector to the interface box.  Fasten the screws of the 
D-type connectors to ensure good connections.  

Since the connection carries the power supply to the Head Stage, it is imperative to 
turn the power off before connecting the Head Stage, and the interface box.   

Refer to Connector Pin Assignment (section 2.6) for a detailed description of the 
pin assignment. 

2.5 Ground Connections and Shielding 
The Head Stage pre-amp has instrumentation (differential) input, which makes it 
easier to overcome grounding problems. The Head Stage Pre-amp Box can handle up 
to 4 Channels. 

         

The Head Stage pre-amp channels have a common ground input connector (GND- 
black connector) and a common minus input connector  (In-), The In- of all the pre-
amps connected together (yellow connector). 

The In- and GND should be connecting to the same reference point. 

GND connections should be made so that no ground loops will be generated.  The 
user some times should play around with these connections until the best results are 
achieved.  

Tips and recommendations: 

- All systems used for measurement should be connected to the same electrical outlet 
to minimize ground loops. 

- The space in which the subject animal is located should be shielded, preferably a 
noise-free shielded room. 

- Do not use any devices that operate on AC power, like 100,110 or 220VAC, in 
close proximity to the (shielded) area. 

- Do not use any device that transmits electromagnetic noise (e.g., a monitor) in close 
proximity to the (shielded) area.  If such devices are used, they should be shielded.  

- Do not leave any unused unconnected inputs. These devices should be switched off 
or connected to the ground.         
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2.6 Head Stage & Interface Box Pin-out Connections 
Interface Box Output Connector (male)    

       1     2 3            4           5        6   7 8         

                   9            10          11           12           13          14           15    

1- NC 
2- NC 
3- KEY 
4- Sine Input for Impedance measure 
5- Output 4 
6- Output 3 
7- Output 2 
8- Output 1 
9- VEE (-12V) 
10- VCC  (12V) 
11- GND 
12- GND 
13- GND 
14- GND 
15- GND 

                                            

Interface Box Input Connector (female)        

1. Input 1 
2. Input 2 
3. Input 3 
4. Input 4 
5. GND 
6. Sine for Impedance measure  
7. RELAY2 
8.       RELAY4    
9.       GND 
10.     VCC (12V) 
11.     GND 
12.      -VEE (-12V) 
13. GND 
14. RELAY1 
15. RELAY3 

8        7       6        5        4        3       2        1 

  15     14      13      12     11     10      9
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Head Stage Pre-Amp Output Connector    

               

  1. Input 1 
  2. Input 2 
3. Input 3 
4. Input 4 
5. GND 
6. Sine for Impedance measure  
7. RELAY2 
8. RELAY4    
9. GND 
10. VCC (12V) 
11. GND 
12. -VEE (-12V) 
13. GND 
14. RELAY1 
15. RELAY3   

Head Stage Instrumentation Pre-Amp Input Connector   

1- Input +  (red connector labeled with channel number) 
2- GND (one black connector for all channels)  
3- Input - (one yellow connector for all channels)  

1       2       3        4       5        6       7        8

 
9     10     11      12     13      14     15
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Head Stage Pre-Amp. , Interface box & MCP-Plus8  

 

                                                                                                                

Interface Box     

        

Head Stage Pre-Amp     
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Mixer & MCP-plus8   

       

Mixer Box (Rear panel) 

      

Mixer Box (Front panel) 

    

Mixer output 
to speaker 
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2.7 MCP-Plus Pin-out Connections 
MCP-Plus Output Connector (female)   

               8 7            6            5       4   3    2 1          

               15           14           13           12           11          10           9  

1- Filtered out 1 
2- Filtered out 2 
3- Filtered out 3 
4- Filtered out 4 
5- Unfiltered out 1 
6- Unfiltered out 2 
7- Unfiltered out 3 
8- Unfiltered out 4 
9- Analog Ground 
10- +12V 
11- Analog Ground 
12- -12V 
13- Digital Ground 
14- +5V 
15- Analog Ground  

MCP-Plus Input Connector (male)    

      1     2 3            4           5        6   7 8      

                9            10          11           12           13          14           15  

1- Digital Ground 
2- +5V 
3- Analog Ground 
4- Sine Output 
5- Input4 + 
6- Input3 + 
7- Input2 + 
8- Input1 + 
9- -12V 
10- +12V 
11- Analog Ground 
12- Input4 - 
13- Input3 - 
14- Input2 - 
15- Input1 -  
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MCP-Plus Control Connector on I/O module (female)    

                         

1- Floating +12V for Pre-Amp H.S. 
2- Floating Ground for Pre-Amp H.S. 
3- Control line 1 (On/Off) output 
4- Control line 3 (On/Off) output 
5- +5V 
6- Control I/N output 
7- Floating -12V for Pre-Amp H.S. 
8- Control line 2 (On/Off) output 
9- Control line 4 (On/Off) output  

MCP-Plus Digital I/O 1 connector (female)  
This connector is used to connect all the control signals and power to the Audio-Mix 
Electrode Stimulus Multiplexer . This connector should be connected to the Power 

and Control

 

connector situated at the rear panel of the Audio-Mix.   

       1      2     3     4     5     6      7     8     9   10    11    12   13      

              14   15   16   17    18   19    20   21   22    23   24   25   

1   - IN0 14  IN1 
2   - IN2 15  IN3 
3   - IN4 16  IN5 
4   - IN6 17  OUT0 
5  -  OUT1 18  OUT2 
6   - OUT3 19  OUT4 
7   - OUT5 20  OUT6 
8   - OUT7 21 - Digital Ground 
9   - +5V 22  Stimulation On/Off 
10 -  +5V 23 - OPTN 
11 - VCC 24  AUD-CLK 
12 - -VEE 25 - EN 
13 - ONOFF     

  5         4          3

 
       2

 
    1

 

9         8         7         6
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MCP-Plus Digital I/O 2 connector (female)           

1. RS1 (RANGE SELECT1) 
2. RS0 (RANGE SELECT0) 
3. CS-POT 
4. SD-IN (SEARIAL DATA INPUT) 
5. CLK-POT 
6. GND 
7. MAN-CON (MANUAL CONTROL MODE) 
8. STIM-ON/OFF 
9. SHDN-POT 
10. STIM-BACK 
11. AD1-BACK 
12. AD0-BACK 
13. VCC 
14. GND 
15. -VEE   

RS232 Serial communication Connector to PC (male)   

                                        

1- NC 
2- Transmit (TXD) 
3- Receive (RXD) 
4- Clear To Send (CTS) 
5- Digital Ground 
6- NC 
7- NC 
8- Ready To Send (RTS) 
9- NC  

15     14         13      12        11        10        9

 
 8          7          6          5 

 
     4

 
  3          2          1 

 

1          2

 

          3

 

       4

 

    5

 

6        7        8          9
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2.8 Power Cord Connection 
Check that the MCP-Plus power switch is off.  Verify that the line filter sign 
(100V/110V /220V) is compatible with the line voltage supplied. Then plug the 
power cord's female plug into the electricity connector on the rear panel and plug the 
male plug into the main power connection (wall socket). 

2.9 Installing an Analog I/O Module Card  
This section includes instruction for the installation of an additional analog I/O 
module in an MCP-Plus system.  

Counting from left to right, the output modules have addresses of 1 to 64 (e.g. the 
first module has address 1; the second Module has address 2 etc.). The new module 
card will be installed at the address N. Remove the blank front panel and the blank 
rear panel of address N by removing the 2 fastening screws at the top and bottom of 
the each panel. Check the module address in the dipswitch table. (Ref. to Output 
Module Card Layout and the Analog I/O Board Base Address dipswitch table).  After 
setting the dipswitches, insert the new Module in the rear panel within the top and 
bottom card guides and guide it carefully until it reaches the end and press firmly 
until you feel that the connector is engaged. Fix in position using the two fastening 
screws. Connect the 20-pin connector to the connector on the front panel using the 
short flat cable supplied and fix in position using the two fastening screws. The new 
Module is now positioned within the frame. 

Note : To remove an analog I/O module, first unscrew the front panel and disconnect the 20 
pin flat cable and then take out the module from the rear panel by unscrewing the  
2 fastening screws, and pulling the module out. 

Table 2-1 SW1 - Analog I/O Board Base Address Dip-Switch Set 
SW1 Dip 

 

switches 
1 2 3 4 5 6 7 8 Address  

 

off on on on on on on on 1 

 

on off on on on on on on 2 

 

off off on on on on on on 3 
on = "0" on on off on on on on on 4 
off = "1" off on off on on on on on 5 

 

on off off on on on on on 6 

 

off off off on on on on on 7 

 

on on on off on on on on 8 

 

off on on off on on on on 9 

 

on off on off on on on on 10 

 

off off on off on on on on 11 

 

on on off off on on on on 12 

 

off on off off on on on on 13 

 

on off off off on on on on 14 

 

off off off off on on on on 15 

 

on on on on off on on on 16 

 

off on on on off on on on 17 

 

on off on on off on on on 18 

 

off off on on off on on on 19 

 

on on off on off on on on 20 
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off on off on off on on on 21 

 
on off off on off on on on 22 

 
off off off on off on on on 23 

on = "0" on on on off off on on on 24 

 
off on on off off on on on 25 

 
on off on off off on on on 26 

off = "1" off off on off off on on on 27 

 

on on off off off on on on 28 

 

off on off off off on on on 29 

 

on off off off off on on on 30 

 

off off off off off on on on 31 

 

on on on on on off on on 32 

 

off on on on on off on on 33 

 

on off on on on off on on 34 

 

off off on on on off on on 35 

 

on on off on on off on on 36 

 

off on off on on off on on 37 

 

on off off on on off on on 38 

 

off off off on on off on on 39 

 

on on on off on off on on 40 

 

off on on off on off on on 41 

 

on off on off on off on on 42 

 

off off on off on off on on 43 

 

on on off off on off on on 44 

 

off on off off on off on on 45 

 

on off off off on off on on 46 

 

off off off off on off on on 47 

 

on on on on off off on on 48 

 

off on on on off off on on 49 

 

on off on on off off on on 50 

 

off off on on off off on on 51 

 

on on off on off off on on 52 

 

off on off on off off on on 53 

 

on off off on off off on on 54 

 

off off off on off off on on 55 

 

on on on off off off on on 56 

 

off on on off off off on on 57 
on = "0" on off on off off off on on 58 

 

off off on off off off on on 59 

 

on on off off off off on on 60 
off = "1" off on off off off off on on 61 

 

on off off off off off on on 62 

 

off off off off off off on on 63 

 

on on on on on on off on 64 
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2.10  Communication Installation 
 The PC Requirements 

- IBM- AT or compatible that can run Windows 9x/2000/NT/XP 

- Minimum 640KB RAM  

- CD ROM Drive 

- Hard Disk 

- RS232 port  

- Monitor SVGA 

 Hardware Installation  
Connect the communication cable to the 9-pin D type male connector on the rear 
panel of the MCP-Plus and to the serial communication card (RS232 port) on the 
rear panel of the PC (either COM1 or COM2). 

 Software Installation  
Insert the CD supplied into the CD ROM drive and run setup. 

Follow the Installation instructions that appear on the screen. 

At the end of the setup process the user is requested to enter the below values 
according to the system purchased.      

 

Click OK and then Finish to finalize the installation. 

The installation program will create a new sub directory on the hard disk called 
MCP-Plus, containing all the relevant files.   



 

MCP-Plus User s Manual 21

 
3 Operation 
3.1 General 

The MCP-Plus is simple to operate. This section explains the principles that are 
fundamental to the MCP-Plus and provides detailed operating instructions. 

The operating procedure consists of the following steps: 

a. Make sure that the MCP-Plus is connected to the main power source, that the 
serial communication cable is connected to the PC, and that the input cables 
are properly connected. 

b. To turn on the MCP-Plus, turn on the power switch on the front panel.  
All MCP-Plus inputs are differential with a very high CMRR (Common Mode 
Rejection Ratio) that enables the user to use long input cable without affecting the 
signal immunity to surrounding electromagnetic fields like line 50Hz or 60Hz.      

3.2 Ready to go 
Double click the MCP-Plus icon 

  

The following window appears:  
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Channel On /Off  

By clicking the On/Off field you can turn the desired channel on and off.                

Notch Filter On /Off  
Available only if Notch Installed box is checked during setup.  Click the "Notch" 
button to turn the Notch filter of the desired channel on and off.   

Gain Select  
One out of possible 500 gains can be applied. The number shown in the gain display 
can be set to include the gain of the pre amp. To change the gain amplification just 
click the gain field and select the desired gain. 

High and Low Pass Filters (HP and LP) 
These two fields control the high pass and the low pass filters. The filters used are 
Butterworth filters that have a very flat pass band response.  The amplitude response 
of this kind of filter is: 

Vout Vin f fc n/ / [ ( / ) ]1 1 2
1

2
      n=2 (No. of poles)  

The high pass is a 2 pole variable filter. The cutoff frequencies applied within the 
high pass filter are from DC to 1Khz with 65 discrete frequencies. The low pass is a 4 
pole variable filter. The cutoff frequencies applied within the low pass filter are from 
100Hz to 10khz with 57 discrete frequencies. 

DC offset  
It is possible to change the DC offset by clicking the offset field and selecting the 
desired DC shift that can range from 50 V - 3V, with over 450 DC levels. 

Microelectrode Impedance Measure 
The microelectrode impedance measure field is usually off during normal operation. 
When switched on, a sine wave generator (100 mV - scientific, 2V  medical version, 

Warnings

 
A.  In order to avoid noise problems perform one of the followings: 

1. In case a stimulator is connected to the Head Stage 

 

ground all unused channels. 

2. In case there is no stimulator  turn unused channels off. 

3. In case there is no stimulator  for unused channels lower 
the gain level to 0. 

B.  All channels in a module should stay on if stimulation current is 
injected into the Head Stage that belongs to this module.  Turning 
a channel off would inject the current into that electrode.    
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1 kHz) is activated and connected to the cable going to the Head Stage. The outputs 
from the Head Stage now give a sine wave of amplitude proportional to the 
impedance of each microelectrode. These outputs are fed to the inputs of the MCP-
Plus. In this mode, the gain in all the Output Module is fixed to 1000(1000 is 
optional), the high pass to 300Hz, the low pass to 5khz and the offset to zero 
automatically. The user can now measure the voltage at the filtered outputs in the 
selected Analog I/O Module. The microelectrode impedance can be calculated using 
the following equation: 

Z= Vo 
where  Z is the microelectrode impedance in Mega Ohms 
and  Vo is the voltage measured at the spike outputs in Volts  

When the user switches the Impedance Measure off, the sine wave generator is 
deactivated and disconnected from the cable going to the Head Stage, and instead the 
analog ground is reconnected. The gain, the Low and High Pass filters and the Offset 
are also restored to their previous settings; i.e. settings existing before entering the 
impedance measure mode. 

3.3 Central Processing Unit 
The central processing unit controls all parameters of gain and filters of the MCP-
Plus at start up and shut down.  At start up, it recalls all parameters from the PC so 
that the user is not required to reset the parameters. 
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3.4 Using the Menu Options 

File menu options:

 
New: Opens a new window (group of modules) if there is a closed one. 

Open: Start a dialog to open a file previously saved in the MCP-Plus.  

Note: if the group of modules window was closed it can be re-opened 
by using the New option (the Open option will not work).   

Close: Closes the active windows (group of modules). The closed window 
can be reopened by the new option. 

Save: Save the parameter into the open file. If no file is opened, the PC 
opens a dialog to enter the file name. 

Save As: Open a dialog to save the parameters into a new file. 

Print: Prints the parameter of all the fields of the MCP-Plus 

Print Preview: Displays the data, as it will be printed. 

Print Setup: Opens the dialog for setting the printer options. 

Exit: Exit the MCP-Plus program. If the parameters are not saved, the 
program saves them into the file Default.dat at before exiting 

Edit menu options:

 

Copy Field: Copy the value of the currently selected field into the program s 
memory. This copied value can be pasted later in the same field of 
any channel(s). 

Copy Channel: Copy the values of all the fields in the current channel into the 
program s memory in order to paste these values later in any 
channel(s). 

Copy Module: Copy the values of all the field of all the channels in the current 
module (module is the 4 channels in one column on the screen. i.e. 
channels 2-1, 2-2, 2-3 and 2-4 are the channels of module number 2). 

Paste: Paste the last copied value(s). If the last copied value is one field 
(Copy Field command), then the paste command loads the value of 
the copied field into the same field in the current channel. If the last 
copy command was Copy Channel, the values of all the fields of the 
copied channel are loaded into the field of the current channel. And if 
the last copy command was Copy Module, the values of the copied 
module are loaded into the current module. 

Paste Module: Paste the last copied values into the current module. If the last copy 
command was copy field, then the same field of all channels in the 
current module is updated. If the last copy command was copy 
channel, then the values of the copied channel are loaded to all the 
channels in the current module. And if the last copy command was 
copy module, the values of the copied module are loaded into the 
current module. 

Paste All: Pastes the last copied value(s) into all channels. If the last copy 
command was copy field, then the same field of all channels will be 
copied. If the last copy command was copy channel, then the values 
of the copied channel are loaded to all the channels. And if the last 
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copy command was copy module, the values of the copied module 
are loaded into all the modules. 

View menu options:

 
Toolbar: Display / hide the toolbar. 

Statusbar: Display / hide the status bar. 

Zoom Channel:  Zoom in on current active channel.  

Zoom All: Zoom in / out.  If the current display is too tight (when more than 8 
modules are displayed on the screen) use the Zoom command to 
enlarge the size of each module.  When in zoom, a scroll bar is 
shown to enable the user to scroll between all the modules in the 
same window. 

Window menu options:

 

Cascade: Arranges all opened windows (groups) in a cascaded (overlapping) 
order.  

Tile:  Arrange all opened windows (groups) in a vertically tiled order.  

Arrange Icons:  Arrange all Minimized windows (groups) at the bottom of the 
main MCP window.  

Next Channel: Select the next channel. (F5) 

Prev Channel: Select the previous channel. (SHIFT+F5) 

Impedance: Select the Impedance button of the current channel. Or, select back 
the current channel. (F7) 

Note: To select the next window (the next group of channels) press the F6 key, to select the 
previous window, press CTRL+F6. 

Setup menu options:

  

The Options dialog box:  

  

Specify the number of modules that are to be used and the number of modules in one 
window.  Check the checkboxes according to the hardware installed on your system. 
See Appendix B for more details regarding the Stim/Rec Switch.  
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Select the audio device installed on the system.  Check the Notch, Isolator and 
Stim/Rec Switch boxes if installed. 

To finalize setup click the OK button.  

Enable / Disable 
Opens a dialog for enabling or disabling a module. Once disabled, a module 
is shown on the screen, but its field s values can not be altered unless it is 
enabled first. 

Serial COMM Number: 
Opens a dialog for changing the serial communication port number. 
When the serial COMM number is changed, the PC attempts to open 
the new COMM, and if successful, it generates a conversation with 
the MCP-Plus. If the MCP-Plus responds, the communication is 
started.  If any error occurred, the PC will inform the user. 

Change PreGain Value 
Opens a dialog for changing the PreGain value.  

The user can change the value for each channel by selecting one of 
these options 1 or 25 or set other value in the edit box. 

                             

  

Use the Prev Channels and Next Channels buttons to navigate 
between channels.     
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Impedance Gain Value 

This option controls the Impedance Gain of the MCP-Plus. User can 
change Gain of the output during impedance measure mode.   

Settings menu options:

 
Stimulus  

Open the Stimulus Control dialog box. In this dialog the user can 
activate/deactivate the stimulus, and if activated, you can select the 
stimulus and the stimulus return addresses.  

     

* Refer to Appendix A for information about the Alpha Stimulus Isolator.  

Isolator 
Open the Stimulus Isolator dialog box. In this dialog user can control 
the Stimulus Isolator. Stimulus Isolator is an optional external device. 
The user can select number of stimulated channel and the ratio of 
conversion for output current. 

Check the According to Stim/Rec Switch box to inform the MCP 
that the Stim/Rec Switch triggers the stimulation externally.   

  

Select: Select the channel of the 
stimulus. 

Return: Ground. 
According to Stim/Rec Switch:  

Check this box to inform the 
MCP that the Alpha Simulus 
Isolator triggers the stimulation 
externally (see Appendix B).  

Start: Start stimulus. 
Stop:  Stop stimulus. 
Close: Close the dialog. If the stimulus 

is active, the Close button will 
deactivate the stimulus. 
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Audio Mixer 
Open the Audio Mixer dialog box. In this dialog user can activate the 
mixing of audio output from multiple channels.   
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4 Client Server  
               Signal conditioning (MCP) client connects to the signal-conditioning server  
               Controlling all the available features, excluding the HW configuration  
               settings.  

              Available client features: 

Gain Control. 

.Filtration control 

Stimulus Isolation Control.  

Impedance Measurements Control. 

. 

4.1 Running the Signal Conditioning Client 

To run the Signal Conditioning Client application do one of the following: 

In the MCP client computer disk top click the MCP client icon.  

Or 
Select Start > Program > MCP client. 

Once the Signal Conditioning Client is running, verify at the status bar that it is 
automatically connected to the server. 

The status bar may indicate either of the following: 

Disconnected 

Working 

  

If the client is disconnected do, the following: 

1. In the server, select Options->TCP Server Options. 

The following window appears: 
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2. Verify that the under Status appears listen... in Connection 1. 
If not, click Start. 

3. In the client select Options > TCP options. 

The following window opens: 

 

4. Under IP Address (connection 1), enter the IP address of the server as it 
appears at the bottom of the TCP Server Options window. 

5. To establish connection, click Start. 

6. Under Status, view the client connection status. 

7. Select File > Get Server Settings to open the workspace. 

4.2 Defining a Workspace 

In the following section you will divide the first 4 channels (1-4) in Module 1 and the 
channels 5-8 in module 2. 

1. In the server application, select Setup > Options. 

2. In the Setup window, in Number of Modules, type 2. 

3. In Module in One Window, type 1. 

4. Click Save. 

The Signal Conditioning main window is as follows: 

Server IP 
address 
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5. In the Signal Conditioning Client, select File > Get Server Settings at the 
application. 

6. Verify that the Signal Conditioning application restarts with the server's 
workspace. 

7. Close module 1. 

8. Select File > Save to save the settings to the workspace. 

9. In the server application, close module 2. 

Each user can control the channels independently without distracting the other 
user.               
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4.3 MCP TCP server commands format 
Command format: 
a= ItemType & ItemName1=ItemVal1 &...& ItemName#=ItemVal#  

Following is a list of supported commands for MCP TCP server:    

List of ItemType: 
MCP_SET Set channel conditioning parameters 
MCP_GET Get channel conditioning parameters 
MCP_STIMULATOR Change parameters for stimulus 
MCP_ISOLATOR Change parameters for Isolator 
MCP_IMPEDANCE Set module to mode Impedance 
MCP_MIXER Change parameters for mixer 

  

List of ItemNames: 
MCP_CHANNEL_NUMBER  
MCP_MODULE_NUMBER  
MCP_PAR_ONOFF  
MCP_PAR_NOTCH  
MCP_PAR_GAIN  
MCP_PAR_LP  
MCP_PAR_HP  
MCP_PAR_OFFSET  
MCP_SET_VALUE  

  

If a parameter is not present then it should not be changed. 
Port number is 8092.  

Examples: 
Set to On channel number 1  

a=MCP_SET&MCP_CHANNEL_NUMBER=1&MCP_PAR_ONOFF=1        
Set to On whole module number 1  

a=MCP_SET&MCP_MODULE_NUMBER=1&MCP_PAR_ONOFF=1         
Get all current parameters of channel number 1  

a=MCP_GET&MCP_CHANNEL_NUMBER=1                        
Begin stimulation of channel number 1 
   a=MCP_STIMULATOR&MCP_CHANNEL_NUMBER=1&MCP_PAR_ONOFF=1 
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5 Stimulation support using the MCP  
The MCP supports three modes of switching an electrode between recording and stimulation 
as follows:  

1. Manual switching at Head stage level using a Start/Stop button  
2. Triggered switching at Head stage level using an external TTL pulse.  
3. Triggered switching at Stimulus Isolator level using an external TTL pulse with the 

option to drop the gain on the other channels.   

The following section will instruct you on how to set your system for each one of the modes.  

5.1 Manual stimulation according to Start/Stop Button 
In this mode the user may select the desired electrode and start/stop stimulation manually by 
clicking a start/stop buttons. This mode could be run with AlphaOmega or any other 
stimulator/Stimulus Isolator.  

Run the stimulation 
1. Go to Settings>Stimulus and verify that the Stimulus control window opens. 

2. Type the desired electrode number in the select stimulation channel.  

  

3. To start stimulation, click the Start Button. 

4. To stop the stimulation click the Stop button. 

5. To close the window and exit the stimulation, click the close button.  

      Clicking this button while stimulation stops the stimulation and closes the          

      Window. 
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5.2 Stim/Rec according to an external trigger.   

MCP ver. 3.5 or higher includes the option to enable/disable the Stim/Rec trigger and set the 
desired Stim channel.   

The External Trigger:

  

Real-Time switching to stimulation or recording is performed when an External TTL Trigger 
(digital signal) is received.  When the signal is High, then the selected channel is switched to 
Stimulation mode. When the signal is Low, then the selected channel is switched to 
Recording mode.   

The external trigger should be connected to the digital I/O connector 1 (D-type female 25 
pin) at the rear panel of the MCP when the digital ground at pin 21 and the stimulation on/off 
at pin 22. (See the MCP rear panel view).   

 

MCP rear panel view.

  

Using the On/Off Stimulation Switch  
Note: User should verify that the MCP has the correct software version. 

         See the MCP software upgrade instructions at appendix B.  

1. Install MCP application 3.5 
2. Select menu item Setup>Options. 

The following window opens:  

 

Digital I/O 1  
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3. Check the box Stim/Rec Switch Installed to enable the TTL trigger to control 

switching from recording to stimulation. 
4. Click OK to close the window.  

5.  Select menu item Settings> Stimulus.   
The following window opens:  

  

6. Check the box According to Stim/Rec switch .  
7. Choose desired channel for stimulation and press Start button.  
8. Circle of On/Off button, of the selected channel at the MCP s main window, turns 

from green to pink color. 
9. Now connection to external trigger signal is enabled and switching between 

Stimulation and Recording modes is possible. When the mode is switched then 
On/Off button turns from pink to red color. 

10. To stop stimulation, press the Stop button in the Stimulus Control dialog.  

To select a different channel, press the Stop button in Stimulus Control dialog and 
change Stimulation channel number. 
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5.3 Stim/Rec  Recording between stimulation . 

       (only with AlphaOmega stimulator).  

The stimulation-recording feature enables the researcher to stimulate with one electrode and 
to record with another between the stimulation periods.  

The following should be available in order to be able to setup and run this feature:  

Alpha Stimulus Isolator.  
MCP (with the suitable Eproms). 
2 TTL Generators. 
Waveform of the desired stimulation current.   

5.3.1 Pulses and wave synchronization 

Without any relation to the source of the TTL pulses and of the waveform, they always 
should stand with the following time definitions to obtain the desired synchronization:    
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800 s

 
The following table summarizes the synchronization time values between the TTL s and the 
waveform pulses.  

Time period 
Name 

Related 
pulse 

Pulse 
explanation 

Related actions 
and results 

Actions 

Value or 
Tolerance 

t_pre_stimulation Wave 
form 

The time 
before 
stimulation 
pulse. 

Before 
t_pre_stimulation 
( s) connect the 
Isolator to the 
load.  

> 125 s 

t_post_stimulation

 

Wave 
form 

The time 
after 
stimulation 
pulse 

After 
t_post_stimulation 
( s) disconnect 
the Isolator from 
the load 

 > 0  

t_pre_gain Stim/Rec 
IN 

The time 
before 
connecting 
the Isolator to 
the load 

In this the MCP 
drop the gain in 
the recording 
channel  

> 100 s 

t_post_gain Stim/Rec 
IN 

The time 
before or 
after 
disconnecting 
the Isolator 
from the 
load. 

In this time the 
MCP returns the 
previous gain as 
before 

-100 s < 
t_post_gain  
< 100 s  

t_duration Wave 
form 

The time 
between two 
pulses.  

t_duration > 
800 s 

 

According to the definitions in the above table we may have recording after 800 sec of the 
stimulation pulse up to 225 sec before the next stimulation pulse. See the following figure:     

         

Recording electrode vs. stimulation pulse 
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5.3.2 Setup Configurations 
The stimulation-recording feature can be run in two deferent configurations depending on the 
TTL s and the waveform source.  

Alphamap or AlphaLab Pro generates the TTL pulses and the waveform. 
External devices generate the TTL pulses and the waveform.  

5.3.3. Connecting the wave form, the TTL s source, and the load to the        

Stimulator.  

Needed Accessories:  

Stimulator Isolator  

AlphaMap/AlphaLab or user s TTL s source device. 

Load Cable. 

Two BNC cables. 

Control cable.  

1. Connect the control cable between the Digital I/O 2 at the MCP and the MCP 
control connector at the stimulator. 

2. Connect the WAVE IN at the stimulator to the Analog Output of the 
AlphaMap/AlphaLab pro or to your waveform source, by one of the BNC cables. 

3. Connect D.out1 at the  Digital I/O of the AlphaLab/Alphamap or the TTL source 
device to the MCP Digital I/O 1 connector at the MCP. 

4. Connect D.out2 at the Digital I/O of the AlphaLAb/AlphaMap or the TTL source 
device to the STIM/REC IN connector I the stimulator. 

5. Connect the Load cable to the stimulator according to the colors of the REF, 
+STIM, -STIM. 

6. Connect the power cable to the power supply connector at the stimulator. 

7. Verify that the STIM/REC switch is in O status. 

8. Connect the load cable to the load according to the following diagram

 

    

Note: regarding the Draw on the next page, you may use a resistor of 10K instead of the load for      
training. In this case the red and green should connected to a one side of the resistor and the black to 
the otherside. 
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5.4 Running the stimulation 
This section will instruct you on how to run the stimulation when the TTL s and the waveform are 
from the AlphaLab or when they are used from an external device. 

5.4.1 The waveform and TTL s are generated by the Alphlab pro 
The waveform and TTL s in the AlphaLab can be generated in two ways:  

1. From the AlphaMap. 
2. From a predefined user text file read by the AlphaMap.  

5.4.1.1 Wave form produced by the Alphamap 

1. Turn on the AlphaLab or the AlphaMap and the MCP. 
2. Activate the signal conditioning and the Data Acquisition applications. 
3. Define the pulses shape in the data acquisition application, as follows:  

Go to Options > Output parameters advanced the following window opens:  

  



 

MCP-Plus User s Manual 40

  
Define the desired waveform parameters. (For testing you may select the default). 
See the AlphaMap manual. 
Click Ok  to close the window and save the changes.  

4. Check and activate the Stim/Rec and Isolator options in the MCP. 
Go to Setup > options. The following window opens:  

   

  

Check the Isolator Installed and the Stim/Rec Switch installed checkboxes. 
Click OK .  

4. Verify that the Stim/Rec switch is in the I status at the stimulator Isolator. 
5. Turn on the stimulator Isolator. 
6. In the signal conditioning application, go to settings > Isolator.   

  

Select the desired channel for stimulation. 
Click the status button so it becomes on .  
Verify that the green led on the isolator is on. 
Start the acquisition at the AlphaMap. 
Click the start stimulus button at the AlphaMap tool bar. 
The current will flow when the Stim/rec pulse is high. 
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5.4.1.2 Wave form produced from a predefined text file.  

1. Activate the MCP and the AlphaMap applications. 
2. In the MCP go to Setup  > options.  

  

Check the Stim/rec switch Installed and the Isolator Installed check boxes. 
Click ok to close the window.  

3. Go to settings > Isolator. The following window opens.  

  

Verify that the according to stim/Rec and the Shut off during stimulus are checked. 
Type the desired channel number in the Channel edit field. 
Select the desired current range and value. 
Click the Status button and make it on .  
Verify that the Stim/Active LED in the stimulator isolator is on. 

.  

4. In the AlphaMap go to Run > Load stimulus pattern. The following window opens. 
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5. Click Browse. The following window opens:  

  

Browse and select the desired stimulation file.  

6. Select the desired data column to start from. 
7. Start Acquisition. 
8. To start the stimulation click the Stimulus button or the Start pattern button at the tool 

bar. 
9. To stop the Stimulation click the Stop button. 
10. To close the Application click the Close button. 
11. You may restart the stimulation while the Acquisition is running by clicking the Start 

pattern button at the tool bar without opening the stimulus pattern file window. 
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The stimulation text file format 
Following is the stimulation text file of the above section with complete explanation. 
Each parameter is bolded with it s value the same as it appears in the file. Right to it appears 
an explanation. 
Channel ID: Accepts the values 0 or 1. 
0                   It determents the analog output Dac. In AlphaMap and AlphaLab it       
                       should Be 0.    

Switching Flag: Accepts the values 0 or 1. 
1                          Indicates if the Stim/Rec time sharing pulses are enabled, this is used                

                      when using an Alpha Omega Stimulator, 
                      If flag=1 then the Digital_Out_Put_Data must be filled with data.   

Repeat Count: Minimum value is 1, maximum is 50000. 
5           Number of times the   analog_Out_Put_Data would be repeated .       

Sampling Rate: Minimum value is 20 maximum value is 100000. 

50000          sampling rate to be used for the D/A, note that possible sampling  

                              rates values are those acceptable by DAP according to the   

                              sampling time. 

                             OutputTime is 1000000/SamplingRate; OutputTime should be an  
                             even number and Minimum OutputTime is 10. 
                              This value is truncated to the nearest possible value. For   
                            example,            
                             16000 is truncated to 16129. 
                            

                                                                                                                                         
Block size: Minimum value is 1 maximum value is 200000.  
 50               Represents the number of samples placed in the analog_Out_Put_Data and      
                    Digital_Out_Put_Data parameters   

Analog_Out_Put_Data: 
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 32767 32767 32767 32767 32767 32767 32767 32767 32767 
32767 -32768 -32768 -32768 -32768 -32768 -32768 -32768 -32768 -32768 -32768 -32768 -
32768 -32768 -32768 -32768 0 0 0 0 0 0 0 0 0 0     

Maximum value is 32767 and minimum value is 32768. 
This block contains the analog data that would be played by the D/A at the output. 
The quantity of data should be equal to the Block size. 
Let us assume that the output voltage that we want to be played is S.   
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The value that should be is   32767*S/5.  

Digital_Out_Put_Data: 
0 0 1 1 1 1 1 1 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 2 2 2 2 2 2 0 0 0 0  

Accepts the values 0,1,2, and 3. 
Each value indicates the Dig.out1 and Dig.Out2 status at the output. This is for controlling 
the AlphaOmega stimulator isolator when recording between stimulation. 

Please see the following table:  

Value Dig.Out 1 value at the 
output (logic value) 

Dig.Out2 value at the 
output (logic value) 

0 Low Low 
1 High Low 
2 Low  High 
3 High High 

  

Delay Time: represents delay between blocks in milliseconds.  
2000                

MCP Command : 
a=MCP_SET&MCP_CHANNEL_NUMBER=0&MCP_PAR_ONOFF=0&MCP_PAR_
NOTCH=1&MCP_PAR_GAIN=145 

Represents commands that could be sent to the MCP through TCP. 
Please refer to the Alpha omega TCP protocol Document for the commends details.  
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5.4.2 The wave form and TTL s are generated by external devices   

1. Activate the MCP and the Alphamap Applications. 
2. Perform steps 2&3 from the previous section. 
3. Start the Waveform and the TTL s pulses on the external device.  

Note: The TTL s should stand with the timing definitions. See pulses and wave syncronization 
section 
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6 Troubleshooting 
6.1 General 

The following section discusses problems that may arise while operating the MCP-
Plus, their possible causes, and the troubleshooting procedures that can be carried out 
by the user. If none of these procedures resolve the problem, contact your service 
representative. 

6.2 No power 
Possible Cause Troubleshooting Procedure 
Wall socket not live Plug another electrical device into the wall socket to 

verify that the socket is live. 

Power cord is not 
installed properly 

Make sure that the power line cord is seated firmly in 
the mains receptacle 

Blown (AC) fuse Unplug the power line cord from the mains 
receptacle. 
Use a screwdriver to pry open the line filter 
access door (ref. to Rear Panel p.11) 
Replace the blown fuse and realign to correct 110V / 
220V. 

 

If only one of the DC supplies is not supplied (you can check that on one of input or 
output connectors) identify which one +5V, +12V, -12V then turn off the system, 
unplug the power cord from the mains socket, and unscrew the fixing screws of the 
power supply module (in the Modular MCP-Plus). On the supply board there are four 
fuses F5: 5V, F6: 5V, F4: +12V, F3: -12V. Replace the blown fuse. 
If none of the above helps to restore power contact your service representative. 

Note:  In addition to the four fuses mentioned above there are two additional fuses  
F1: -12V, F2: +12V, these fuses supply the power for the Head Stage Pre-Amplifiers.  

6.3 Power Supply Unit Malfunction 
Test the voltage at the input sockets to determine a possible malfunction of the power 
supply unit. While the input is connected to one socket, insert a tester in the other. 
The test should indicate readings of -12V, +12V, and +5V. Readings may vary to 
within 10% of these figures.  Readings other than these indicate a problem in the 
power supply unit. If so contact your service representative. To test for a malfunction 
in the floating Head Stage power supply unit, proceed as follows: 

Check input receptacles with a probe to detect the reception of the signal. If a 
signal is not detected, inspect the fuses behind the Head Stage Control on the 
Rear Panel (ref. to Rear Panel p.11). To inspect these fuses, remove the covering 
of the Head Stage Power unit. The fuses are marked (F3, F4). Replace the fuse(s) 
if necessary. 

 If the fuses are in working order, check for a gain or filter malfunction (see 
below). 
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6.4 Channel Malfunction 

If a channel fails to respond, check that the External Shutoff or Remote Control In 
has not been activated. 

6.5 Gain or Filtering Malfunction 
If an error is detected in the signal at any of the analog outputs, the user can apply a 
known signal (Sine wave is recommended) to the Input. The user can check 
changing the amplitude and frequency of the input signal and selecting different 
channels, gains, and cutoff frequencies for every output module. Gain or filter 
malfunctions can originate in a specific Output Module, in the Input Control Module 
or in the Head Stage. Contact your service representative if a malfunction is detected.   

6.6 Faulty Communication with PC   

Possible Cause Troubleshooting Procedure 
Communication cable 
not connected 

Check that the communication cable is 
firmly seated in the 9-pin plug at the 
Rear panel of the MCP-Plus and in the 
PC RS232 card. 

MCP-Plus is not 
switched on 

Switch on the MCP-Plus ensure that the 
red LED on the Control Panel is lit. 

Incorrect RS232 channel 
was selected  

Choose a different channel (the options 
are COM1 - COM4). 

Another system is 
connected to the same 
RS232 channel 

Make sure that the other system has the 
capability to work in this mode, if so 
ensure that the system is on. 

PC RS232 card error Change the RS232 card. 
Malfunction in the 
MCP-Plus Control 
Module 

Contact your service representative.   
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6.7 Frequently Asked Questions 

Q) How do I connect the electrodes to your preamplifier? 
A) The red wires labeled 1-4 should be connected to the positive (input) end of the 

electrode.  The Yellow and black wire Labeled G and - should be connected 
together and clamped using an alligator clip to the ground on the test subject.  

Q) How do I connect stimulation? 
A) Depending on the stimulation source you are using there should be two wires, positive 

lead and negative or ground.  The positive lead from the stimulator should be 
connected to the green wire on the back of the preamplifier.  The ground can be 
connected to the animal.  

Q) How do I measure impedance? 
A) From the MCP software press the bar at the bottom of each module to I.M. ON 

should come on as well as a green circle.  Afterwards, connect the BNC output for 
each channel into an oscilloscope and measure the voltage peak-to-peak.  1 Volt = 1 
M of impedance.  Repeat measurement for all channels.  

Q) How can I set multiple channels with the same gain and filter settings in the MCP? 
A) After setting the desired parameters in one channel, go to the Edit menu and select 

copy channel then select paste to all or past module.

  

Q) What happens to the gain settings after I turn off the PC? 
A) The MCP will always keep the last setting used before closing the software.  In 

addition, you could save the settings into a configuration file that you will open each 
time.  

Q) After installing the MCP setup, every time I am trying to make a change in the MCP 
software I get the message: Check that the MCP RS232 cable is connected

 

A) Change the serial port number in the MCP software.   

Q) Is it possible to have unfiltered output? 
A) Yes, the MCP output can be filtered or unfiltered.  

Q) Can I split a single channel into two outputs (i.e. for the purpose of having spikes and 
LFP for each channel)? 

A) We can supply you with a splitter cable that splits every channel to two channels.  

Q) I have some noise problems.  I can see the noise in the MCP output even if I ground 
all the preamplifier inputs. 

A) In order to pin point the problem and find the source of the noise: 
- Change the MCP location.  Place it away from electrical devices that may affect it. 
- Check your Ground Loop.   

Q) I have an internal mixer.  How do I select a channel to hear sound output?  
A) In the menu bar go to Settings, choose the audio mixer option and then choose 

the channel you want to hear by selecting it.  
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Appendix A  
Alpha Stimulus Isolator 
The new Alpha Stimulus Isolator introduces revolutionary flexibility by providing the 
researcher with many features that were previously not supported by other 
stimulators.  

The Alpha Stimulus Isolator can invert any supplied waveform into current. 
It has a wide Band Width, 100KHz on load of 10K , and provides an 
important tool to perform stimulations in many patterns. 
The useful feature of Current Monitor enables the researcher to have 
information about the current in the load in real time.  

Alpha Stimulus Isolator Rear Panel 

     

Alpha Stimulus Isolator Front Panel 

    

BNC waveform in

 

BNC current 
monitor out 

15-pin MCP 
control for 
stimulator 

Power Supply 

On/Off Indicator

 

Green Led 
Stim Current is 
active  

Red 
Connector 
Stim (+) 

Green 
Connector 
Stim (-) 

Black 
Connector 
Ref (GND)

 

STIM RIC

 

IN 
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Alpha Stimulus Isolator Technical Specifications 

Input 
Signal type:     Arbitrary analog waveform.  
Frequency range: 0 - 100 KHz  
Signal range:    5 V 
Input impedance:  10 K  min. 
Safe input voltage:   30V pp 
Connector:  BNC  

Output (tested with sine and square wave) 
Bandwidth 3dB:          0 -100 KHz   at 10Kohm 
Bandwidth 3dB:          0 - 25 KHz    at 100Kohm 
Bandwidth 3dB:          0 - 3 KHz      at 1Mohm  

Max output Voltage Range:   +/-125V or +/-175V  

Offset Current:    0.01% of full range 
Noise RTO 100KHz BW:                   0.1% of full range 
Output current ranges:  

5uA   - 100uA     
100uA-1mA     
1mA-   6mA  

Output Current Accuracy:  1 %  

Slew Rate:                40 V/ sec (Load=10K)      
20 V/ sec (Load=100K)      
2 V/ sec (Load=1M)  

I=6mA, load = 10Kohm,   Vout=60V 
I=1mA, load = 100Kohm, Vout=125V  

Isolation 
2500VRMS  

Control  
Software control through the AO Multi Channel Processor through a 15 pin   
D-type connection.  

Indicators 
ON/OFF LED 
Stimulus active LED 
Current monitor output through a BNC connector, the CM have the same 
bandwidth of the output. 
Range 100uA =5V in CM 
Range 1mA =5V in CM 
Range 10mA(6mA) =5V in CM 
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Weight 

0.75Kg   

Dimensions 
250 X 145 X 90 mm  

Power Supply  

AC/DC that supplies the isolated parts, 
+/-12V that supplies the non isolated parts. 
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Appendix B  
Installation Instruction for MCP Upgrade 

Older versions of MCP may be upgraded to include the On/Off Stimulation Switch 
feature. 
In order to perform upgrade please follow the below steps:  

Install PLM chips

 

1. Turn off power of MCP box and unplug power cable. 
2. Open MCP box cover. 
3. Carefully remove PLM chips U14 and U15 from MCP control card.  

  

4. Install new PLM chips. Please note, every bank has label MSB or LSB. The 
same labels there are on every chip. Every chip should be inserted 
accordingly. Polarity of chips is important  please note small notch on chip 
and its bracket. 

5. Turn power on and check that a buzz signal is not heard. If a buzz signal is 
heard it means that PLM chips are not inserted properly. 

6. Turn power off. Close MCP box cover. 

MSB-U14 

MSB  U15
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Registration Card  
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System:  
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Problem Description:    

ALPHA OMEGA  

U.S. Office: Toll Free 1-877-919-6288   Fax 1-877-471-2055  

Home Office:  P.O. Box 810, Nazareth Illit 17105, Israel.  Tel. 972-4-6563-327 Fax: 972-4-6574-075  
Email: info@alphaomega-eng.com  Web site:  www.alphaomega-eng.com
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